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Introduction

Project management is a broad term that can mean something very formal and spe-
cific to one person, but something very organic and pieced together to another.
The fact of the matter is that “pieced together” can get you only so far. Spread-
sheets, sticky notes, and email are all great tools, and they may work fine for
smaller projects, but when you start adding just a few more people working on a
project, or just one or two more reports to generate for upper management, proj-
ect management becomes more complicated. Your blood pressure goes up a
smidge and gathering bits and pieces from the various tools you’ve been using to
track your projects gets to be more tedious than you may have time for.

Microsoft Project 2010 addresses these issues gracefully and powerfully. I can’t lie;
it has a steep learning curve, but it’s absolutely worth your time to figure it out,
even at a rudimentary level. The amount of time it ultimately will save you is reason
enough. And as you complete projects, you can review the project data to help
make decisions about future projects. It’s a thing of beauty, really, especially if
you’ve been used to a lot of manual updating and high-maintenance project and
resource tracking.

Project 2010 is versatile enough to help bring order to a novice project manager’s
plans, while offering rich solutions for experienced project managers. The latter will
benefit from items such as earned value and critical path analysis, resource level-
ing, and heavy customizability to meet organizational needs.

How This Book Is Organized

This book introduces you to Project 2010. It is designed to familiarize you with proj-
ect management terminology, as it is used in Project 2010, and covers functionality
that was brought forward from previous versions of Project, as well as features that
are new in Project 2010. This book is far from a be-all, end-all reference book for
Project 2010. Instead, it focuses on introducing the concepts and procedures that
are most commonly used. Using Microsoft Project 2010 offers you the following:



• Some high-level project management theory, as it applies to Project 2010

• An introduction to new features in this version

• An orientation to Project 2010, including the different parts of the Project
window and the many views available to you

• A walkthrough of the process of creating a project, from adding tasks and
assigning resources, to tracking costs and reporting on progress

• Information about some simple customization options, as a starting point for
more advanced topics

• Some solutions to commonly encountered project issues

Using This Book

This book allows you to customize your own learning experience. The step-by-step
instructions in this book give you a solid foundation in using Project 2010, while
rich and varied online content, including video tutorials and audio sidebars, pro-
vide the following:

• Demonstrations of step-by-step tasks covered in this book

• Additional tips or information on a topic

• Practical advice and suggestions

• Direction for more advanced tasks not covered in this book

Here’s a quick look at a few structural features designed to help you get the most
out of this book:

• Chapter objective—At the beginning of each chapter is a brief summary of
topics addressed in that chapter. This objective enables you to quickly see
what is covered in the chapter.

• Notes—Notes provide additional commentary or explanation that doesn’t fit
neatly into the surrounding text. Notes give detailed explanations of how
something works, alternative ways of performing a task, and other tidbits to
get you on your way.

• Tips—This element gives you shortcuts, workarounds, and ways to avoid pit-
falls.

• Cautions—Every once in a while, there is something that can have serious
repercussions if done incorrectly (or rarely, if done at all). Cautions give you a
heads-up.
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• Cross-references—Many topics are connected to other topics in various
ways. Cross-references help you link related information together, no matter
where that information appears in the book. When another section is related
to one you are reading, a cross-reference directs you to a specific page in the
book on which you can find the related information.

LET ME TRY IT tasks are presented in a step-by-step sequence so you can
easily follow along.

SHOW ME video walks through tasks you’ve just got to see—including
bonus advanced techniques.

TELL ME MORE audio delivers practical insights straight from the experts.

Special Features

More than just a book, your Using product integrates step-by-step video tutorials
and valuable audio sidebars delivered through the Free Web Edition that comes
with every Using book. For the price of this book, you get online access anywhere
with a web connection—no books to carry, content is updated as the technology
changes, and the benefit of video and audio learning.

About the Using Web Edition

The Web Edition of every Using book is powered by Safari Books Online, allowing
you to access the video tutorials and valuable audio sidebars. Plus, you can search
the contents of the book, highlight text and attach a note to that text, print your
notes and highlights in a custom summary, and cut and paste directly from Safari
Books Online.

To register this product and gain access to the free Web Edition and the audio and
video files, go to quepublishing.com/using.
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4
Working with Tasks

This chapter walks you through adding tasks to your
project in Project 2010.

After you have created and saved your initial project plan, the next step is to add
tasks to your project. It’s important to understand the different types of tasks that
Project 2010 offers. With a basic understanding of task types, you can add tasks to
your project and then set up dependencies between the tasks. Project 2010 also
provides a framework for adding work breakdown structure codes to your tasks, if
your organization uses them.

Understanding Task Types

Each task in your project can be one of three different types:

• Fixed units

• Fixed work

• Fixed duration

These task types are used to determine which element of a task is most important
for scheduling, so that Project knows what it should maintain as it sets your pro-
ject’s schedule. Project calculates the schedule using the following formula:
Duration = Work / Units.

Table 4.1 shows what changes Project makes, based on task types, for a task that is
set to automatic scheduling.

Table 4.1 Task Types

Task Type Adjust Units Adjust Work Adjust Duration

Fixed units Duration is adjusted. Duration is adjusted. Work is adjusted.

Fixed work Duration is adjusted. Duration is adjusted. Units are adjusted.

Fixed duration Work is adjusted. Units are adjusted. Work is adjusted.
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Fixed Units

Fixed units is the task type to pick if the level of effort on your project is important
to you. For example, let’s say you assign a resource to a task, and you know you can
only use that resource for that task half time. You assign the resource at 50% (units).
After your initial planning, you find out that you need to make the task longer, or
you discover that the task may take more work than you thought. You don’t want
Project to change the units, so you choose the fixed units task type. This leaves the
resource assigned at 50%, and Project recalculates the work or duration, based on
what factor you changed.

Looking at this from a formula perspective, say the original duration of the task is
5 days, the work is initially set to 20 hours, and the units is set to 50%. The formula
would look like this: 5d = 20h / 50%. If the task is fixed units, you can’t change
the 50%.

• Changed duration—If the duration is increased to 10 days, Project will
adjust the 20 hours of work to maintain a balanced equation: 10d = 40h /
50%. Because the task is set to fixed units, the resource will always work at
50%. So if you increase the duration, the resource will work more hours. Pro-
ject will increase the work to 40 hours.

• Changed work—If the work is increased to 40 hours, Project will adjust the
5 days of duration, because the resource is only able to work at 50%, or
20 hours per week. It will take the resource 10 days to get 40 hours of work
done, working 20 hours per week. This adjustment maintains a balanced
equation: 10d = 40h / 50%.

Fixed Work

If a task is set to fixed work, Project will maintain the amount of work scheduled
for the task. Look again at the previous example: 5d = 20h / 50%.

• Changed units—If you need to keep the task set to 20 hours of work, and
you find out that your resource is only available at 25% instead of 50%, Pro-
ject will adjust the duration to 10 days because it will take the resource
longer to get the work done if he or she is working fewer hours each week.
This maintains a balanced equation: 10d = 20h / 25%.

• Changed duration—If you find out that you have 10 days to get the task
done, instead of 5, Project will adjust the units to 25%, because it will take
less of the resource’s time each week to get the work done. This maintains a
balanced equation: 10d = 20h / 25%.
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Fixed Duration

If a task is set to fixed duration, Project will maintain the length of time you’ve set
aside to complete the task. Again, return to the example: 5d = 20h / 50%.

• Changed work—If the amount of work increases to 40 hours, with the dura-
tion fixed at 5 days, Project will adjust the resource units. Instead of 50%, the
task now requires 100% to get 40 hours of work done in 5 days. The balanced
equation is: 5d = 40h / 100%. You can get to 100% by increasing the amount
of time the existing resource works in a week, or by assigning additional
resources to the task.

• Changed units—If you find out that the resource assigned to the task is now
available at 100% of his or her time, Project will adjust the amount of work for
the task, to maintain the 5 days of duration: 5d = 40h / 100%. Because the
resource is assigned at 100%, he or she can fit in 40 hours of work in 5 days,
instead of 20 hours.

SHOW ME Media 4.1—Learn More About Task Types

Access this video file through your registered Web Edition at

my.safaribooksonline.com/9780132182461/media.

Adding Tasks to Your Project

When adding tasks to your project in Project 2010, you can choose to fill out a lot
of detail about your tasks upfront, or you can enter some basic scheduling informa-
tion at first and then fill in more details later.

SHOW ME Media 4.2—Working with Tasks

Access this video file through your registered Web Edition at

my.safaribooksonline.com/9780132182461/media.

LET ME TRY IT

Adding a New Task

To add a new task to your project, follow these steps:

1. In the Gantt Chart view, type a name for the new task in the first empty
row of the Task Name column.
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To insert a new task between two existing tasks, right-click a task row and click
Insert Task to add a new row above.

2. Click the Task Mode column and then choose whether you want the task
to be Manually Scheduled or Auto Scheduled. Project uses one of these
methods as a default. You only need to choose a method if you don’t want
to use what is set as the default.

Not sure whether you want Manually Scheduled or Auto Scheduled? Review
“How Does Project 2010 Schedule Tasks?” in Chapter 3, “Starting a Project,” for more
information on scheduling in Project 2010 or view Show Me Media 4.3. If you choose
Manually Scheduled, be sure to listen to Tell Me More Media 4.4 for some best
practices.

3. Type the number of days over which you want the task work completed in
the Duration column. You also can use minutes (m), hours (h), weeks (w),
or months (mo) if one of these would be more appropriate for your
project.

4. Set the task’s Start and Finish dates:

• If you selected Auto Scheduled in step 2, the Start and Finish columns
will be populated automatically with the appropriate dates, based on the
project scheduling options you chose when you created the project (see
Chapter 3). Do not manually set a start or finish date if you are using
automatic scheduling.

• If you selected Manually Scheduled in step 2, choose a Start date, and
Project will fill in a Finish date. Alternatively, choose a Finish date, and
Project will fill in a Start date. Project calculates the Start or Finish date
using the information you entered in the Duration column.

5. To set additional task details, go to the Task tab of the ribbon. In the
Properties group, click Details to display the Task Details Form view split
with the Gantt Chart view, as shown in Figure 4.1.

6. Use the Task Details Form view to set the following:

• Task type—Choose whether the task is Fixed Duration, Fixed Units, or
Fixed Work.

• Constraint—By default, this field is set to As Soon As Possible, meaning
that the task could happen at any appropriate time in the project. You
also can choose As Late As Possible, if that makes more sense for your
project. However, you may have some tasks that need to happen in
coordination with a specific date. You can choose from the following
constraints: Finish No Earlier Than, Finish No Later Than, Must Finish
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Figure 4.1 Click Details on the Task tab to display the Task Details Form view, split with
the Gantt Chart view.

When choosing a constraint for a task, keep in mind that what you choose can
impact Project’s ability to do things like enforce links to other tasks and properly
distribute resource work on the task.

7. Click OK to save your task settings.

SHOW ME Media 4.3—Automatic Versus Manual Scheduling

Access this video file through your registered Web Edition at 

my.safaribooksonline.com/9780132182461/media.

TELL ME MORE Media 4.4—Best Practices for Working with Manually

Scheduled Tasks

Access this audio file through your registered Web Edition at

my.safaribooksonline.com/9780132182461/media.

On, Must Start On, Start No Earlier Than, and Start No Later Than. If
you choose one of these constraints, be sure to choose an associated
date using the Date box within the Constraint box.
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Setting a Task Calendar

Sometimes, a task in your project may need to use a different schedule from the
rest of your project. For example, let’s say a specific task needs to happen over a
weekend. The overall project calendar has the weekends set as nonworking days.
You can set a separate calendar for that task, so that the weekend days are set as
working days. Other tasks in your project will still see the weekend as nonworking
days, but the task with the modified task calendar will see the weekend as
working days.

Follow these steps to set a separate calendar for a task:

1. On the Project tab of the ribbon, in the Properties group, click Change

Working Time.

2. Click Create New Calendar.

3. Choose how you want to create the task’s calendar:

• Create new base calendar—Click this to create a new calendar for your
task, from scratch. Working times will be set to the calendar options from
the Project Options dialog box, by default.

• Make a copy of [existing base] calendar—Click this to use an existing
base calendar as a starting point for your task’s calendar. Use the drop-
down list to choose which base calendar you want to copy.

4. Type a name for your task’s calendar in the Name box. You may want to
use a name that helps to identify this as a calendar that is intended for use
on a specific task. This will help to differentiate it from the base calendars
for your project.

5. Click OK to create your task’s calendar.

6. Similar to creating a base calendar, set the working days, nonworking
days, default working times, and working times for specific time periods in
your task’s calendar.

For more information on these procedures, see “Setting Up Your Project’s
Calendars” in Chapter 3.

7. With your task’s calendar set up and saved, double-click the task row in
the Gantt Chart view.

8. Click the Advanced tab and then choose the calendar you just created
from the Calendar list.

9. Click OK to save the calendar setting.
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Indenting and Outdenting Tasks

After you have a list of tasks added to your project, you may find that you want to
add some organizational structure to your tasks. You can indent and outdent tasks
to add hierarchy to your project. Tasks that have other tasks indented below them
are called summary tasks. Tasks that are indented below another task are called
subtasks. Summary tasks roll up data from their subtasks. For example, if a sum-
mary task has two subtasks, the summary task will take the earliest start date and
the latest finish date from those subtasks, as shown in Figure 4.2.

To indent or outdent a task, click the task in the Gantt Chart view to select it. Then,
on the Task tab of the ribbon, in the Schedule group, click Indent or Outdent, as
shown in Figure 4.3.

Figure 4.2 Subtasks roll up data to the summary task level.

Figure 4.3 Use the Indent and Outdent buttons to create hierarchy in your tasks.
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You can also choose to display the project summary task, which will roll all tasks
and summary tasks up to the very top level of the project. To display the project
summary task, click the File tab on the ribbon, click Options, and then click
Advanced. Under Display options for this project, select the Show project

summary task check box and then click OK.

Setting Up Task Dependencies

Some tasks in your project may have certain relationships with other tasks in your
project. For example, you may have a task that can’t begin until another task has
ended. These relationships are called dependencies. Project offers four different
types of dependencies for your project’s tasks:

• Finish-to-Start (FS)—A finish-to-start dependency is one in which a second
task cannot begin until the first task has ended.

• Start-to-Start (SS)—A start-to-start dependency is one in which a second
task cannot begin until the first task has begun.

• Finish-to-Finish (FF)—A finish-to-finish dependency is one in which a sec-
ond task cannot finish until the first task has finished.

• Start-to-Finish (SF)—A start-to-finish dependency is one in which a second
task cannot finish until the first task has begun.

Figure 4.4 shows these four types of dependencies.

Start-to-Start

Finish-to-Finish

Start-to-Finish

Finish-to-Start

Figure 4.4 Project provides four types of dependencies.
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Let’s walk through an example that uses all four of these types of dependencies. In
this example, you are planning to remodel the kitchen and dining area in a home.
You use Project to track each of the tasks involved in this process.

Here are the tasks you want to track for the remodel:

• Rewire kitchen—This involves moving outlets, wiring through cabinets for a
built-in microwave, and adding an outlet on a kitchen island.

• Install new cabinets—This involves installing new wall cabinets, and cabi-
nets to support a new countertop.

• Paint—This involves painting both the kitchen and dining areas.

• Install counters—This involves placing a new countertop on top of the new
cabinetry.

• Install new floors—This involves placing new flooring in both the kitchen
and dining areas.

• Install new appliances—This involves installing several new kitchen 
appliances.

Each task has some sort of dependency on another task. The “Rewire kitchen” task
can’t be finished until the “Install new cabinets” task has started, because some of
the wiring needs to be done through the new cabinetry (wiring for a built-in
microwave, and an outlet on the island). This is a start-to-finish dependency in
Project.

The “Paint” task has a start-to-start dependency on the “Rewire kitchen” task. That
is, the painting can’t start until the electrician has started the process of rewiring.
The electrician needs to have moved openings for outlets and light fixtures, as nec-
essary, before the painters can come in and begin painting the kitchen and dining
areas. The electrician doesn’t need to be done with all of his work for the remodel
before the painters can start, just the portion of work that impacts the painters.

The “Install counters” task can’t start until the “Paint” task has finished. By setting up
this finish-to-start dependency, you avoid getting drips of paint all over the shiny
new countertops. This type of dependency is most commonly used in project
plans.

The “Install new floors” task can’t finish until the “Paint” task has finished. The
painters begin by painting the ceiling in both the kitchen and dining areas, then
move on to painting the kitchen. After the kitchen is painted, the flooring installers
begin their work in the kitchen, while the painters finish painting the dining room.
The flooring team can’t finish its work until the painters have finished painting the
dining room. At that time, the flooring team can finish its work by flooring the din-
ing room. In Project, this is represented as a finish-to-finish task.
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Figure 4.5 Example of dependencies within a project

Finally, the “Install new appliances” task can’t start until the “Install new floors” task
has finished. This is another finish-to-start dependency.

Project represents these task dependencies on the Gantt chart using arrows
between the tasks. Figure 4.5 shows how our example might look if we entered it
into Project and set up the dependencies.

LET ME TRY IT

Adding Dependencies Between Tasks

In Project, dependencies between tasks are recorded in the row for the second task
in the dependency. For example, if you are creating a dependency in which Task B
can’t start until Task A has finished (a finish-to-start dependency), you would record
the dependency in the row for Task B. When you record the dependency, you indi-
cate the task’s predecessor.

To quickly set start-to-finish dependencies between tasks in your project, select the
rows for the tasks you want to link, and then, on the Task tab, in the Schedule

group, click Link Tasks.

If you want to set up other types of dependencies, create gaps between tasks, or
overlap tasks, you can set up dependencies using the Predecessors column.

To set up a dependency between two tasks using the Predecessors column, follow
these steps:

1. In the Gantt Chart view, be sure the Predecessors column is displayed.



75S ett ing Up Task  Dependencies

If the Predecessors column is not displayed, scroll all the way to the right of the
table portion of the Gantt Chart view and then click Add New Column. Click
Predecessors in the list that appears, to add the column to the view. You can
click and drag the column header to move the column to another location in
the table portion of the view.

2. In the row for the second task in the dependency you’re creating, type the
ID number (located in the row header) for the first task in the dependency
in the Predecessors column. Also, indicate the dependency type.

For example, if you are creating a dependency between Task A (ID number
1) and Task B (ID number 2), you would type the following for each
dependency type:

• Finish-to-start—To indicate that Task B can’t start until Task A finishes,
type 1 in the Predecessors column for Task B, as shown in Figure 4.6. Pro-
ject assumes a finish-to-start dependency, by default, so you don’t need
to include a dependency type abbreviation.

• Start-to-start—To indicate that Task B can start only after Task A has
started, type 1SS in the Predecessors column for Task B.

• Finish-to-finish—To indicate that Task B can finish only after Task A has
finished, type 1FF in the Predecessors column for Task B.

• Start-to-finish—To indicate that Task B can finish only after Task A has
started, type 1SF in the Predecessors column for Task B.

3. If one of your tasks needs to overlap another (known as “lead time”), or needs
to fall behind another (known as “lag time”) by a certain amount, type this in
the Predecessors column, as well:

• Overlap two tasks—To overlap two tasks, type a negative duration, or
percentage, after the task ID number and dependency type in the
Predecessors column, as shown in Figure 4.7. For example, if you want
Task B to start one day before Task A is scheduled to start, type 1SS-1d in
the Predecessors column for Task B.

Figure 4.6 In this example, Task B has a finish-to-start dependency on Task A.
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• Insert a delay between two tasks—If the second task needs a delay
after the start or finish of the first task, type a positive duration, or per-
centage, after the task ID number and dependency type in the
Predecessors column, as shown in Figure 4.8. For example, if you want
Task B to start when Task A is 50% through its scheduled duration, type
1SS+50% in the Predecessors column for Task B.

Creating a Work Breakdown Structure (WBS)

Some organizations require the use of a work breakdown structure to align project
tasks with accounting systems, business strategies, and so on. It is a method of
making sure that all work is accounted for, and decomposed into small enough
packages for tracking and management. In Project, a work breakdown structure
(WBS) is represented as an elaborate outline, providing each task with a WBS code
that identifies where it falls within your project plan.

For example, let’s say you have a project with the task structure shown in Table 4.2.

Figure 4.7 Insert lead time in the Predecessors column.

Figure 4.8 Insert lag time in the Predecessors column.
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Table 4.2 Example Task Structure

Task Name

Design Phase

Identify requirements

Conduct survey

Prioritize results

Write specification document

Develop Phase

Code product

Write code

Test code

Table 4.3 WBS Codes

Task Name WBS Code

Design Phase EX_Design

Identify requirements EX_Design_1

Conduct survey EX_Design_1.a

Prioritize results EX_Design_1.b

Write specification document EX_Design_2

Develop Phase EX_Develop

Code product EX_Develop_1

Write code EX_Develop_1.a

Test code EX_Develop_1.b

In a WBS code, each indent level in your task structure is given a set of letters, num-
bers, or characters that you define. For example, the phases in the example may be
given a set of characters; the tasks may be given a number; and the subtasks may
be given a lowercase letter. In Project, you can also assign a prefix for the code, to
indicate the task’s project. If you use the combination of characters, numbers, and
letters just described, with a prefix of “EX_” to indicate that this is an example proj-
ect, the WBS codes might be assigned as shown in Table 4.3.



C h a p t e r  4 | Work ing with  Tasks78

To display outline numbers for your project, with the Gantt Chart view displayed,
click the Format tab on the ribbon and then select the Outline Number check box
in the Show/Hide group. The outline numbers appear to the left of each task’s
name.

Confused about when to use which? This depends on your organization. If
you’re just trying to identify where a task falls in your project, outline numbers
may be enough. However, if you’re using the numbers to sync with another sys-
tem, or to communicate with others about your project, WBS codes provide a
richer, more descriptive way of outlining your project’s tasks.

LET ME TRY IT

Setting Your Project’s WBS Code Structure

You can set your project’s WBS code structure at the beginning, before you have
tasks added, if you know enough about how many levels of tasks you might use
and what information the code needs to capture. You may, however, have an easier

Table 4.4 Outline Numbers

Task Name WBS Code Outline Number

Design Phase EX_Design 1

Identify requirements EX_Design_1 1.1

Conduct survey EX_Design_1.a 1.1.1

Prioritize results EX_Design_1.b 1.1.2

Write specification document EX_Design_2 1.2

Develop Phase EX_Develop 2

Code product EX_Develop_1 2.1

Write code EX_Develop_1.a 2.1.1

Test code EX_Develop_1.b 2.1.2

Note how the tasks and the WBS codes are starting to look like an outline. Project
also includes an automatic outline scheme that simply uses increasing numbers,
separated by periods, to indicate where a task falls within a project. Table 4.4 shows
the example tasks, WBS codes, and their corresponding Project outline numbers.
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time building out your WBS code structure after you know what your project’s
tasks really look like.

Follow these steps to set up a WBS code structure for your project:

1. On the Project tab of the ribbon, in the Properties group, click WBS and
then click Define Code.

2. If you want to use a prefix to identify which project the tasks belong to,
type a prefix in the Project Code Prefix box, as shown in Figure 4.9.

As you build out your WBS code structure, the Code preview box shows an
example of what your code will look like for a task at the lowest level in your
project.

3. Use the columns and rows in the Code mask table to build out your WBS
code structure. Each row represents an indent level for tasks in your
project. Figure 4.10 shows a defined code mask.

• Sequence—Choose whether you want to use Numbers, Uppercase

Letters, Lowercase Letters, or Characters.

If you choose to use Characters, the Code preview box shows an asterisk (*) as
a placeholder for the characters, and you can type the characters in the WBS
field for your project after you have your code structure set up.

Figure 4.9 Use the Project Code Prefix box to include text before the ordered portion of 

the code.
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• Length—Choose the number of characters you want to use for this part
of your WBS code. If you choose one character and the number of tasks
at this level goes beyond nine, a WBS code will not be assigned, and
you’ll receive an error message. Also, if you choose two or more charac-
ters, single-digit numbers will begin with a zero (01, 02, 03, and so on). If
you want to avoid both of these circumstances, leave it set to Any.

• Separator—Choose a character to separate this part of your WBS code
from the next part. You can choose one of the built-in separators (period,
hyphen, plus sign, or slash), or type one of your own.

4. Select the Generate WBS code for new task check box if you want to
automatically create a WBS code for each task you add to your project.

5. Select the Verify uniqueness of new WBS codes check box if you want
each WBS code to be unique. This can be helpful if you have used the
Characters option in the Sequence column.

6. Click OK to save your WBS code structure.

After you have your WBS code structure set up, the next step is to display the WBS
code in the Gantt Chart view, so you can see the fruits of your labor.

To display the WBS column, follow these steps:

1. With the Gantt Chart view displayed, right-click the column that you want
to appear to the right of the WBS column.

Figure 4.10 Use the Code mask table to define your WBS code.
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2. Click Insert Column and then scroll down and click WBS from the menu that
appears. Figure 4.11 shows the Gantt Chart view with the WBS code
displayed.

Figure 4.11 The WBS column displays the WBS code for each task.
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between, 74-76
fixed duration, 66
fixed units, 66
fixed work, 66
indenting/outdenting,

71-72
manually scheduled, 9
resources

assigning, 87-89
work schedule, fine

tuning, 91-92
splitting, 90-91

Team Planner view, 9-10, 34
work resources,

assigning, 89

templates
for basic reports, 126
for visual reports, 123

timeline, 10-11, 15-16
copying, 132
Format tab, 15
sharing with others, 16

Timeline view, 34-35

Tracking Gantt view, 34-35

troubleshooting projects
cost overages, 195-197
overallocated resources,

189-193
schedule extending past

deadline, 193-195

Trust Center options, Project
Options dialog box, 187

U-V

updates, assessing impact
of, 119-120

User Interface options
Project Options dialog

box, 150-151

user interface, ribbon, 14-15

versions of Project 2010, 5

views
Bar Rollup view, 16-17
Calendar view, 17-19
columns

adding, 12, 141-142
hiding, 142

combination views,
creating, 147-148

creating, 145-147
data

filtering, 40-41
grouping, 36-38
highlighting, 41-43
sorting, 38-40

Descriptive Network
Diagram view, 19-20

Detail Gantt view, 20-21
Format tab, 14
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Gantt Chart view, 20-21
Gantt with Timeline view,

20-22
Leveling Gantt view,

20-22
Milestone Date Rollup

view, 23
Milestone Rollup view, 23
multiple, displaying, 43-44
Multiple Baselines Gantt

view, 24-25
Network Diagram view,

24-25
Relationship Diagram

view, 26
Resource Allocation 

view, 26-27
Resource Form view, 26
Resource Graph view,

26-28
Resource Name Form

view, 28
Resource Sheet view, 29
Resource Usage view,

29-30
Task Details Form view, 29
Task Entry view, 29-31
Task Form view, 31-32
Task Name Form view,

31-32
Task Sheet view, 31-33
Task Usage view, 31-33
Team Planner view, 9-10

work resources,
assigning, 89

timeline, 10-11
Timeline view, 34-35
Tracking Gantt view,

34-35

visual reports, 121
generating, 123-126
templates, 123

W

WBS (work breakdown
structure)

code structure, setting,
78-81

creating, 76-78

work resources, 82

working day, changing to
nonworking day, 54-55

working time, changing for
specific time period, 57

X-Y-Z

XPS files, saving projects
as, 134
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